
വിവര വിനിമയ സാേങതികവിദയ
സാേനരഡ് 10

മാതകാ േചാദയങള 
(തീയറി - ഒനാം പാദവാരഷിക പരീക)

വിഭാഗം 1 : ശരിയതരം െതരഞടകക(  ½ േസാര)

1. ഒര ചിതതിെന  dpi കടേമാള അതിെന  സകതയം ഭംഗികം എന്  മാറമാണ് സംഭവികക   ? 

a) വരദികന
b) കറയന
c) മങലണാകന
d) ഒനം സംഭവികനില

Answer : a) വരദികന

2. െവകര ചിതങള നിരമികാന ഉപേയാഗികന േസാഫ്െവയറകളാണ് ചവെട തനിരികനത് . 
എനാല ഇവയിെലാന് ഓപണ േസാഴ് േസാഫ് െവയറല.   ഏത് ?

a) ഓപണ ഓഫീസ് േഡാ
b) ഡയ
c) അേഡാബ് ഇലേസറര
d) ഇങ്േസപ്

Answer : c) അേഡാബ് ഇലേസറര

3. ഇകേസപ് ജാലകതിെല ടളബാറില കാണന ഒര ടള ആണ് ചിതതില കാണനത്. 
 ഈ ടള എനിന് ഉപേയാഗികനതാണ് ?

           a) ഒബകിെന നിറം മാറാന    
           b) േഗഡിയെന കളര നലകാന
           c) ഒബകിെന െസലക് െചയാന
           d) ഒബജകകെള ഒറ യണിറാകാന

           Answer : c)ഒബകിെന െസലക് െചയാന

4. ഇങ്േസപ് േസാഫ്ട് െവയറില അനപ് വരച അമീബയെട ചിതതിന് േയാജിച നിറം നലകാന  
ചവെട െകാടതിരികനതില ഏത് സേങതമാണ് ഉപേയാഗിേകണത്.

a) Edit > Duplicate         –
 b)Edit > Clone–

c)Object > Fill and Stroke  –
 d)Object  > Object Properties–

 Answer : c)  Object > Fill and Stroke  –



5. ഇങ്േസപ് േസാഫ്െവയറില േഡവിഡ് വരച  അമീബയെട ചിതെത റാസര ചിതമായി േസവ്  
െചയാനളള മാരഗം ഏത് ?

a)file.....>Save as Bitmap
b)file.....>Export Bitmap
c)file......>Insert Bitmap
d)Edit.....>Bitmap

Answer :  b) file.. . . .>Export Bitmap

6. ഇങ്േസപ് േസാഫ്ട്െവയറില  ഒര ചിതതിെന എത പകരപകള േവണെമങിലംഎടകാം .  
അതിനായളള സേങതം ഏതാണ്

a) Path  differance→
b) Edit path by node
c) Path  Union→
d) Edit   duplicate→

Answer: d) Edit   duplicate→

7. ഇങ്േസപ്   േസാഫ്ട്െവയറില  വരകന  ചിതങള  വലതാകിയാലം  മിഴിവ്  
നഷെപടാതിരികനത് ഏത് കാരണം െകാണാവാം?

a) ചിതങെള അേനകം സമചതരങളായി വിഭജിചിടളത് െകാണ്.
b) ചിതങള ഗണിതസമവാകയങളെട രപതില ഓരതെവകനതെകാണ്.
c) ചിതങെള പികലകളെട സമഹമായി പരിഗണികനതെകാണ്
d) ചിതതിെല  സമചതരങളക് നിറം നലകനതെകാണ്.

Answer : b)ചിതങള ഗണിതസമവാകയങളെട രപതില ഓരതെവകനതെകാണ്

8. ഇങ്േസപ്  േസാഫ്ട്െവയറില   അനിത   വരച  ചിതമാണ്  താെഴ  െകാടതിരികനത്. 
ചിതതിെന േസാക് കളറില  (stroke colour) മാറം വരതിയാല ഉണാവന ഫലം ?

a) വതതിെന ഉളഭാഗതിെന നിറം മാറം 
b) വതതിെന വരയെട നിറം മാറം 
c) വതതിന് പറതള ഭാഗതിെന നിറം മാറം
d) ഇനകേസപ് േസാഫ്െവയര ജാലകതിെന നിറം മാറം

Answer : b) വതതിെന വരയെട നിറം മാറം



9. ഇങ്േസപ് േസാഫ്ട്െവയറില രേമശന വരച ചിതതിെന േപര്  rose.svg  എനാണ്.  ഇതില  
svg എനതിെന പരണ രപെമന്?

a) Scalable Velocity Graphics 
b) Scalar Volume Graphics
c) Scalable Vector Graphics
d) Sector Vector Graphics

 Answer : c)  Scalable Vector Graphics

10. അമലിന്   ഇങ്േസപ്  ഉപേയാഗിച് ധാരാളം  ഇതളള  ഒര  പവ്  വരയണം.  ഒര  ഇതള  അമല 
തയാറാകിയിടണ്  മററ്  ഇതളകള  എളപതില  നിരമികാന  ഏത്  മാരഗമാണ് 
അവലംബിേകണത് ?

a) Object    Group→
b)  Path   Exclusion→
c) Edit  Duplicate     →
d) Text   Put on path                                                       →

 Answer : c) Edit  Duplicate→

11. ഇങ്േസപ്  േസാഫ്ട്െവയറില  സനിത ഒര തിേകാണവം വതവം ചിതം  A  യിേലത്  േപാെല 
വരച. ഇതിെന ചിതം B യിെല േപാെല പരണമാകാന സവീകരിേകണ ടള ഏത്?

         

a)  Object  Group→
b)  Object    Raise→
c)   Path    Difference→
d)  Path    union→

Answer: d) Path    union→

12. ഇങ്േസപില  നിരമിച ചിതങള png േഫാരമാറിേലക് മാറാന :

a) File    New → കിക്െചയക
b) File    Import  → കിക്െചയക
c) File    Export bitmap  → കിക്െചയക
d) File    Open  → കിക്െചയക

Answer c) File    Export bitmap→



13. ഇങ്േസപ് േസാഫ്െവയറില അന തയാറാകിയ ഒേര കയാനവാസിലള മന് ചിതങെള ഒരമിച്  
േചരകനതിനള സേങതം ഏത്?

a) Object group–
b) Edit - clone
c) Object - Fill and Stroke 
d) Edit  copy–

Answer : a)  Object group–

14.  അന  ഇങ്േസപില  ഒര  വതം  വരച.  അതിനേശഷം  ഒര  ടള  ഉപേയാഗിച്   അതിെന 
അരധവതമാകി മാറി. ഏതായിരികം ആ ടള ?

 a) Draw Bezier curves and straight lines.
b) Create circle
c) Zoom 

 d) Edit paths by nodes

Answer : d) Edit paths by nodes

15.  ഇങ്േസപില  വരച  രണ  വതങളാണ്  താെഴകാണനത്.  ഒനാമെത  വതതിെന  നിറം 
രണാമെത വതതിേനത േപാെല ആകവാന ഉപേയാഗിച േഗഡിയന് ഏതായിരികം ?

 

a) Linear gradient
b) Radial gradient 
c) Pattern gradient
d) Fill gradient

Answer : b) Radial gradient

16. സ്െപഡഷീറില വിവരങള തരംതിരികനതിന്   ഉപേയാഗികന സേങതമാണ്  കണീഷണല  
േസറ്െമന്.  കണീഷണല േസറ്െമനിേലകായി ഉപേയാഗികന ഫങഷന ഏത് ?

a) LOOKUP
b) COUNT
c) RANGE
d) IF

Answer : d) IF

17. നിങളക് പരിചയമള ഒര സേങതമാണ് . ഇെതനിെന സചിപികന?

a) Mail Merge Wizard
b) Function Wizard
c) Data Source
d) Data Forms

Answer : b) Function Wizard



18. ഒര കാസിെല മഴവന കടികളേടയം  വിവരങള പടികെപടതിയേപാള രണ് കടികളക് ഒേര 
Admission  Number  െകാടതതായി  കണ.    ഈ  െതറ്  ഒഴിവാകാനായി   OpenOffice.org 
Database ല ഉള സൗകരയം താെഴപറയനവയില ഏതാണ്?

a) Field Name
b) Table 
c) Primary Key
d) Forms

Answer :  c) Primary Key

19. ഡാറാേബസില ചില പേതയക വിവരങള തിരയനതിന് ഏത് സേങതമാണ്   ഉപേയാഗികനത്?
a) േടബിള
b) േഫാം
c) കവറീസ്
d) റിേപാരട്

Answer : c) കവറീസ്

20. Define  Range  ല േസവ്  െചയനതിനായി  തയാറാകിയ  Lookup  Chart  ആണ്  ചിതതില  
കാണനത്.  Exam എന േപരിലാണ്  ഇത േസവ് െചയത്.  േഗഡ് നിരണയികാന LOOKUP 
Function Wizard ല ഏത് ഭാഗതായിരികം Exam എന വാക് നലകിയിടണാകക ?

a) Search Criterion
b) Search Vector
c) Result Vector
d) Range Vector

Answer : b) Search Vector

21.  ഒര ഡാറാേബസിേലക് നലകന വിവരങള േശഖരികെപടനത് ഏതിലാണ് ?
a) DataForm
b) Report
c) Queries
d) Table

Answer : d) Table
22 ഓപണഓഫിസ് ഡാറാേബസ് ജാലകം തറനാല കാണന സൗകരയങള ഏെതലാം?

a) Tables, Queries,Forms, Reports
b) Tables, Functions, Forms, Reports
c) Queries, Tables, Save, Functions
d) Tables, Queries, Functions, Save

Answer : a) Tables, Queries,Forms, Reports



23. ഒര കാസിെല കടികളെട  വിവരങള പടികയാകിയിടണ്.  മഴവന കടികളകം െനയിംസിപ്  
തയാറാകാന സഹായികന സേങതം

a) ഡാറാേഫാം 
b) െമയില െമരജ്
c) ലക്അപ്
d) ചാരട്

Answer : b) െമയില െമരജ്

24 രമ ടീചര തെന കളാസിെല  കടികളക് വിവിധ വിഷയങളില ലഭിച േസാറകള  സ്െപഡ്  
ഷീറില  ൈടപ െചയ.   ഓേരാരതരേടയം േഗഡ് കാണണം. ഇതിനായി ഏത്  സേങതമാണ് 
ഉപേയാഗികക?

a) LOOKUP
b) ROUND
c) COUNTIF
d) AVERAGE  

Answer : a)  LOOKUP

25. കാസ്  ലീഡറായ  മേനാജിേനാട്   കാസ്  ടീചര  സ്െപഡഷീററില  തയാറാകിയ  പടികയില  
കാസിെല   കടികളെട  ഒനാം  പാദവാരഷികപരീകയെട   മാരകിെന  അടിസാനതില  
േഗഡ്  തിരിയാന ആവശയെപട.  ഇത് എളപതില െചയാന  മേനാജ്  ഏത് ഫങഷന ആണ്  
ഉപേയാഗിേകണത് ?

             a) SUM
             b) AVARAGE

  c) LOOKUP
  d) INDEX

Answer :  c) LOOKUP

26. ഡാറാേബസ്  െറയഞ്   ഡിൈഫന  െചയേപാള  നലകിയ  േപര്   LOOKUP  ഫങഷന  
വിസാരഡിെല ഏത് ഫീലഡിലാണ് (box) േചരേകണത് ?

                     a) Search  Criterion
                     b) Search Vector

c) Result Vector
                     d) Result Criterion
   
             Answer :  b) Search Vector 
27 ഓപണ ഓഫീസ് ഡാറാേബസില ധനയക് ഒര പടിക  തയാറാകണം.  ഇതിന്  േടബിള എന 

സേങതതില നിന് ഏത് ടാസ് ആണ് തിരെഞടേകണത് ?

a) Use Wizard in Create Table...
b) Create Form in Design View...
c) Use Wizard to Create Form...
d) Use wizard to Create Report...

Answer:  a) Use Wizard in Create Table.. .



28 രമടീചരക്  ഓപണ  ഓഫീസ്  ഡാറാേബസില  തയാറാകിയ  അഡ്മിഷന  രജിസ്ററമായി  
ബനെപട  പടികയിേലക്  വിവരങള  നലകാന  സഹായകമായ  ഓപണ  ഓഫീസ്  
ഡാറാേബസിെല സേങതേമത് ?

a)  Tools    
b)  Queries    
c)  Forms      
d)  Reports

                                  
Answer : c) Forms 

29. തെന കാസിെല  ഓേരാ കടിയെടെടയം ആെക മാരക് ഉളെപടന സ്െപഡ് ഷീററിെല പടിക 
ഉപേയാഗിച്  അവെര വിവിധ േഗഡകളിലായി തരം തിരികാന റഷീദ് ഉപേയാഗിച സേങതം?

a)  IF       
b)  LOOKUP     
c)  COUNTIF      
d)  ROUND

Answer  :   b)  LOOKUP 

30. സരകിതമായി ഒര ഡാറാേബസിെന ൈകകാരയം െചയാന സഹായികന േസാഫ്െവയറകളെട 
െപാതവായ േപരാണ് DBMS.  DBMS െന പരണരപം ?

a) ഡാറാേബസ്  മാേനജിംഗ്  സിസം
b) ഡാറാേബസിക്  മാേനജെമന് സിസം
c) ഡാറാേബസിക്  മാേനജിംഗ്  സിസം
d) ഡാറാേബസ്  മാേനജെമന് സിസം

Answer : d) ഡാറാേബസ്  മാേനജെമന് സിസം

31. ഒര  പേതയക  ആവശയതിനായി  േശഖരിച  വചിരികന  വിവരങളെട  കടം  എന  
വിേശഷിപികാവനത്

a) Inkscape
b) IDLE
c) Gimp
d) Database

Answer : d) Database 

32. സ് െപഡഷീറില ഡാറാേഫാം സേങതതിെന ഉപേയാഗം ?

a) വിവരങള പടികയില ഉളെപടതനതിന്
b) വിവരങള വിശകലനം െചയനതിന്
c) വിവരങള അയകനതിന്
d) വിവരങള തരം തിരികനതിന്

Answer : a) വിവരങള പടികയില ഉളെപടതനതിന്



33. താെഴ പറയന ഏത് േസാഫ് െവയറിെന സഹായേതാെടയാണ് നമക്  ൈപതണ േകാഡകള 
നിരമികാന കഴിയക ?

a) wxGlade
b) Sunclock
c) Inkscape
d) GeoGebra

Answer  :  a) wxGlade 

34 wxGlade  എന േസാഫ് െവയറിെല ചില ടളകളെട ചിതങളാണ് ചവെട െകാടതിരികനത്.  
ഇവയില  Add a TextCtrl  ടള ഏെതന് കെണതക.

a)

b)

c)

d)

Answer : c) 

35. a=1
      b=2
          print 'a'+'b'

ഷാന  തയാറകിയ ൈപതണ േപാഗാം ആണ് മകളില െകാടതിടളത്.  ഈ േപാഗാമിെന  
output എനായിരികം ?

a) 12
b) 3
c) ab
d) a+b

Answer : c) ab

36. a=range(10,1,-2) 
        print a
    മകളില െകാടതിടള ൈപതണ ഈ േപാഗാമിെന output എനായിരികം ?

a) -2  -4  -6  -8  -10
b) 10  8  6  4  2  0
c) 10  8  6  4  2
d) -10  -8  -6  -4  -2

Answer :  c) 10  8  6  4  2



37. രാജ താെഴ നലിയിരികന രീതിയില ഒര ൈപതണ േപാഗാം തയാറാകി. ഇതിെന ശരിയായ 
ഔട്പട് എനായിരികം? 

p= MY INDIA“ ”
n=len(p)
print n

a)  7   
b)  8
c)  6
d)  10

Answer : b)  8

38. ഒര python േപാഗാമില turtle ഗാഫിക് ഉളെപടതനതിന് ഉപേയാഗികന നിരേദശം എന്?

a) insert  turtle

b) from turtle import*

c) show turtle()

d) turtle import*

Answer :  from turtle import*

39. ൈപതണ േപാഗാമില  e='7' എന നിരേദശതിെന ഉപേയാഗം എന്?

 a)  e എന ചരതില 7 എന സംഖയ േശഖരികനതിന്

 b)  e എന ചരതില 7 എന സംഖയ അകരമായി  േശഖരികനതിന്

 c)  e എന ചരതില 7 അകരങള  േശഖരികനതിന്

 d)  ഇവെയാനമല

Answer :   e എന ചരതില 7 എന സംഖയ അകരമായി  േശഖരികനതിന്

40. െടകസ്  േബാകകള  വഴി  കമയടറിേലക്  നലകന  സംഖയകള  നയമറിക്  േഡറയാകാന  

python േപാഗാമില  ഉപേയാഗികന ഫങഷന ഏത് ?

a)  Num

b)  int

c) Value

d)  string

Answer :  int



41. ഒര  ൈപതണ  േപാഗാമില  ഉളെപടിടള ഏെതങിലം  നിരേദശങള  ഒര  നിശിത  തവണ  

പവരതികണെമങില െകാടേകണ നിരേദശം  

a) for

b) import

c) raw_input

d) print

Answer :  a) for

42. ചില  ഫയല നാമങള താെഴ  െകാടതിരികനത്  ശദികക.  ഇവയില നിനം ൈപതണ  

ഭാഷയില തയാറാകിയ  ഫയല െതരെഞടകക.

a) calculator.svg

b) calculator.odt

c) calculator.png

d) calculator.py

Answer :  d) calculator.py

43. ശയാം തയാറാകിയ ഒര ൈപതണ േപാഗാമാണ് താെഴ െകാടതിരികനത്. ഈ േപാഗാം റണ 
െചയാല കിടന output എനാണ്? 

a= WE ARE INDIANS” ”
print a[:6]

a) WE 
b) INDIANS
c)ARE INDIANS
d)WE ARE

Answer :  d) WE ARE
44. ഒര  ചരതില  വയതയസമായ  5  വിലകള  േശഖരികനതിനേവണി  ൈപതണ  േപാഗാമിംഗില 

െകാടകാവന നിരേദശം താെഴ െകാടതിടളവയില നിന് കെണതക
a) for

   b) while
   c) i=range(5)
   d) range[5]

Answer :  c)  i=range(5)



45. അവേരാഹണകമതില  5  മതല  1  വെരയള സംഖയകള  i   എന ചരതില േശഖരികനതിന് 
താെഴ തനിടള ഏത ൈപതണ നിരേദശമാണ് ഉപേയാഗികക?

a)  i = range (5,0,-1)
b) i = range (5,0,1)
c) i = range (5,1,-1)
d) i = range (1,5,-1)

          
Answer :  (a) i = range (5,0,-1)

            
46.  ൈപതണ േപാഗാമിെല ഏത് നിരേദശേതാെടാപമാണ് range എന ഫങഷന ഉപേയാഗിേകണത് ?

a) for
b) while
c) if
d) print

Answer : a) for

47. രണ്  സംഖയകളെട  തക കാണനതിനള ഒര ഫങഷന, sum.py  എന േപരില സനില തെന 
േഫാളഡറില േസവ് െചയ.  മെറാര േപാഗാമിേലക് ഈ ഫങഷന െകാണ് വരണെമങില സനില 
ആദയം െകാടേകണ നിരേദശം ഏത് ?

a) import sum.py
b) import sum
c) print sum
d) print sum.py

Answer :  b) import sum
48.  ൈപതണ  െഷലില  range(4,2,-2)  എന്  നലകി  Enter  കീ  അമരതിയാല  പവരതനഫലം 

എനായിരികം?

a) [4,2,-2]
b) [4]
c) [4,2]
d) [4,3,2]
Answer       :    b) [4]

49. a = k  “ ”
for i in range (1, 11): 

   print i * a 

മകളില  തനിരികന  േപാഗാം  ൈപതണില  പവരതിപികേമാള  എത  വരികളിലാ 
യിടായിരികം ഉതരം പദരശിപികക

a.) 11
b.) 12
c.) 1
d.) 10

Answer    :  d) 10



50. ൈപതണ ഭാഷയില നിരമിച ഒര ഫങഷന പവരതിപികേമാള ഉണാകന ഉതരം തിരിെക 
പധാന േപാഗാമിന് ലഭികണെമങില ഉപേയാഗിേകണ നിരേദശം ഏത്?

a) print
b) return
c) import
d) input

Answer :  b) return

51. a= WELCOME” ”
print a[:2] എന ൈപതണ േപാഗാമിെന output ?

a) WE
b) ME
c) LC
d) CO

       Answer :    a)  WE

52. അനപ് നിരമിച  'rm'  എന ഫങഷനാണ്  നലകിയിരികനത്
def rm(a,b)
 c=a-b
 return c
ഈ ഫങഷന എന് ആവശയതിന് േവണിയളതാണ്

a) രണ് സംഖയകള  കടനതിന് േവണി
b) രണ് സംഖയകളെട വയതയാസം കാണനതിനേവണി
c) a,b എനീ ചരങള നിരവചികനതിനേവണി
d) a,b എനീ ചരങള േപാഗാമില ഉപേയാഗികനതിന് േവണി

Answer :b)രണ് സംഖയകളെട വയതയാസം കാണനതിനേവണി
53. www.wikimapia.org  തറന് രഘ തെന സളിരികന സലം കെണതി അടയാളെപടതാന  

ശമികകയാണ്  .  സളിെന  വിവരങള  ഉളെപടതാനള  ജാലകം  ലഭികനത്  
എേപാഴായിരികം?

a. Edit map  കിക് െചയേമാള
b. Map Type കിക് െചയേമാള 
c. Save ബടണില കിക് െചയേമാള 
d. Add place ല കിക് െചയേമാള

Answer :  c. Save ബടണില കിക് െചയേമാള
54. കവാണം ജിസ് േസാഫ്െവയറില ഒര സാനീയ വിവരതിേനാട് േചരന് നിശിത അകലം വെര  

പേതയക േമഖല സഷികന പവരതനം സാദയമാകന buffer സേങതം എത െമനവിലാണ് ?

a. Layer
b. Vector
c. File
d. Edit

Ans:-   b. Vector



55. ഒര കയജിസ് ഭപടെത സംബനിച് ശരിയായ പസാവന ഏത്?

a.കയജിസ് ഭപടതില ഒര പാളി മാതമാണളത് .
b.കയജിസ് ഭപടതില ആദയ പാളി റാസര  പാളിയം മറളവ െവകര പാളികളമായിരികണം. 
c.ഒര പേദശതിെന  സവിേശഷതകള  ഇനം തിരിച്  പേതയകം  പാളികളില       

േരഖെപടതിയാണ് കയജിസ് ഭപടംനിരമികനത് 
d.കയജിസ് ഭപടതില ആദയ പാളി  െവകര പാളിയം മറളവ റാസര പാളികളമായിരികണം. 

Answer :    c.ഒര പേദശതിെന  സവിേശഷതകള  ഇനം തിരിച്  പേതയകം പാളികളില 
േരഖെപടതിയാണ് കയജിസ് ഭപടംനിരമികനത് 

56.  കയജിസ്  േസാഫ്റ്െവയറില ബഫര  െചയ പാളിയിെല അളവകള  കതയമാേണാ എനറിയാന 
ഏത റള ഉപേയാഗികാം.

a). Node Tool
b). Measure Line Tool
c). Move Tool
d). Map Tips

Answer :  b) Measure Line Tool

57. കയജിസ്   േസാഫ്റ്െവയറില  േവണ  സ്കള  സിതി  െചയന  പേദശതിെന മാപ്  
നിരമികകയാണ്.  തിരെഞടത  േപാളിഗണ  െലയറില   പേദശതിെന  അതിരകള  
േരഖെപടതാന ഏത റളാണ് ഉപേയാഗിേകണത് ?

  a. Toggle editing 
  b. New Print Composer
  c. Zoom Mode
  d. Buffer(s)

Answer :  Toggle editing 

58. നടതറ  പഞായത്  ,  പഞായതിെന  ഭപടം  ഡിജിറലായി  തയാറാകാന  ഉേദശികന.  
അതിനായി ഉപേയാഗികാവന ഏറവം അനേയാജയമായ േസാഫ്െവയര തിരെഞടകക .

a) Stellerium
b) Q GIS
c) GIMP
d) wxGlade

Answer :  b) Q GIS

59. കയജിസ്   േസാഫ്റ്െവയറില  ഭപടം  നിരമികേമാള  ഒര  പേദശതിെല  േറാഡകള  
ഉളേകാളന ലയര നിരമികവാന അനേയാജയമായ െലയര ൈടപ് ഏതാണ് ??
a) േപാളിഗണ
b) ൈലന
c) േപായിന്
d) സരകിള 

Answer: b) ൈലന



60.  പാേദശികാസതണതിെന ഓേരാ സപധാനഘടങളിലം ഏറവം ഫലപദമായി ഉപേയാഗികാന 
കഴിയന ഒര സവതന  േസാഫ് െവയറാണ്.
a)Stellerium
b)Q GIS
c)GIMP
d)wxGlade

Answer:  b)Q GIS

61. കയജിസ്  േസാഫ്റ്െവയറില ഒര സാനീയ വിവരതിേനാട് േചരന്  നിശിത അകലം വെര  
പേതയക േമഖല സഷികന പവരതനം സാദയമാകന ബഫര  സേങതതിേലക് േപാകാനള 
പവരതന കമം ഏത്?

A.  Vector - Geoprocessing Tools - Buffer(s)
B.  Raster - Geoprocessing Tools - Buffer(s)
C.  Mark - Geoprocessing Tools - Buffer(s)
D.  Vector  Geometry Tools - Buffer(s)–

Answer :  A. Vector - Geoprocessing Tools - buffer(s)

62. വികിമാപിയ ഏത തരം ഭപടമാണ് ?
a. ചമര ഭപടം
b. ഉപഗഹ ഭപടം
c. കയജിസ്   ഭപടം
d. േഗാബ്

Answer :   b.ഉപഗഹ ഭപടം

63. കയജിസ്  േസാഫ്റ്െവയറില  ഒര പാളിയിെല മഴവന വിവരങളം പടികയായി ലഭികാന  ഏത് 
പവരതനമാണ് െചേയണത് ?

a) Layer     N→ ew     N→ ew Shapefile Layer 
b)  Layer    → (right click)    O→ pen attribute table 
c)  Vector    → Geoprocessing tools    → Buffer 
d)  Vector   → Geoprocessing tools    → Intersect

Answer :   b    Layer    → (right click)    O→ pen attribute table 



വിഭാഗം 2 : ഏറവം അനേയാജയമായ രണ് ഉതരങള െതരഞടകക (1  േസാര)

1.  ഇങ്  േസപ്  േസാഫ്ട്െവയര ഉപേയാഗിച്   സരിത ഒര വതം വരച .ഇതില  fill  and  stroke 
സേങതം ഉപേയാഗിച് വരതാവന മാറങള കെണതക.

a) ചിതതിെന വലിപം വയതയാസെപടതല
b) ചിതതിന് നിറം നലകല
c) വരകളെട കടി കടല

   d) േപജിെന പശാതല നിറം വയതയാസെപടതല

Answer :   b)ചിതതിന് നിറം നലകല
c)വരകളെട കടി കടല

2. ഇങ്  േസപില വതസംഭം  വരകന  പവരതനം  െചയേമാള  ചതരവം  അടിഭാഗെത  ദീരഘ 
വതവം  A യില  കാണനത  േപാെല  വരച.  B  യില  കാണന  രപതിലാകാന  താെഴ 
പറയനവയില ഏെതാെക രണ് പവരതനങളാണ് ഉപേയാഗിേകണത്

a) edit path by node tool ഉപേയാഗികക
b) ദീരഘ വതവം ചതരവം ഒരമിച് െസലക് െചയക

c) path     →   difference

d) path →union

Answer:
b)ദീരഘ വതവം ചതരവം ഒരമിച് െസലക് െചയക

d) path →union           

3. താെഴ  െകാടതിരിയനവയില  ഇങ്േസപിെല  ടളേബാകില 
കാണന ടളകള ഏെതലാം ?

a) smudge Tool 

b) Edit path by nodes

c) Create Circle Tool

d) Healing Tool 

 Answer :   b) Edit path by nodes 
  c) Create Circle Tool 

 



4.  ഇനങ്േസപ്  േസാഫ്െവയറില പദീപ്  തയാറാകിയ  ഒര േലാേഗായാണ്   തനിരികനത്  ചവെട  
നലകിയിരികന  ഏതലാം പവരതന ഘടങളിലെട ആയിരികം ചിതം പരതീകരിചിടണാവക.

a)             (create rectangle tool) ഉപേയാഗിച് 3 ചതരങള നിരമിച് അനേയാജയമായ നിറം നലകി.

b)            (Transform tool) ഉപേയാഗിച് 3 ചതരങള നിരമിച് അനേയാജയമായ നിറം നലകി.

c) െടകസ് ടള (Text tool) ഉപേയാഗിച് ചതരതിനകത്  'IT  @ School' എന് 
ൈടപ് െചയ് അകരം ഭംഗിയാകി

d) (select path by node tool) ഉപേയാഗിച് ചതരതിനകത് '
IT  @ School' എന് ൈടപ് െചയ് അകരം ഭംഗിയാകി

Answer:
a)          (create rectangle tool) ഉപേയാഗിച് 3 ചതരങള നിരമിച് അനേയാജയമായ  
നിറം നലകി.

c) െടകസ് ടള (Text tool) ഉപേയാഗിച് ചതരതിനകത്  'IT  @ School'  
എന് ൈടപ് െചയ് അകരം ഭംഗിയാകി

5.  Inkscape ല ഒര ബഹഭജം വരയനതിനള രണ് ടളകള കെണതക.

a) Create spirals Tool ഉപേയാഗിച് ബഹഭജം വരയക.

b) Create stars and polygons ടള ഉപേയാഗിച് ബഹഭജം വരയക.

c) Draw Bezier curves and straight lines Tool    ഉപേയാഗിച് ബഹഭജം വരയക.

d) Text ടള ഉപേയാഗിച് ബഹഭജം വരയക.

Answer:
b) Create stars and polygons ടള ഉപേയാഗിച് ബഹഭജം വരയക.

c) Draw Bezier curves and straight lines Tool ഉപേയാഗിച് ബഹഭജം വരയക.



6. ഇനകേസപ്,  ജിമ്  ഈ  േസാഫെവയറകെള  സംബനിച്  ചവെട  നലകിയിരികനവയില 
ശരിയായ പസാവനകള ഏത്?

a) ഇനകേസപില ഒേര ജാലകതില തെനയാണ് ടളകളം കയാനവാസം 
b) ഇനകേസപില വയതയസ ജാലകങളിലാണ് ടളകളം കയാനവാസം
c) ജിമില ഒേര ജാലകതില തെനയാണ് ടളകളം കയാനവാസം
d) ജിമില വയതയസ ജാലകങളിലാണ് ടളകളം കയാനവാസം                                       

Answer: 
    a) ഇങ്േസപില ഒേര ജാലകതില തെനയാണ് ടളകളം കയാനവാസം 

d) ജിമില വയതയസ ജാലകങളിലാണ് ടളകളം കയാനവാസം

7. ഇങ്േസപ് േസാഫ് െവയറില തയാറാകിയ ഒര ഒബകിെന അതിലതെനയള മെറാര ഒബകിെന 
പിറകിലായി കമീകരികനതിനള 2 മാരഗം ?

a)Page Up
b)Object → Lower
c)Page down Key
d)Object  Transform→

Answer:
 b)Object  Lower,   →
 c)Page down

8. േഗാപിക  ഇങ്േസപ്  േസാഫ്െവയര  ഉപേയാഗിച്  ഒര  േഗാളം  വരച .  ഇതിനായി  െചയ 
പവരതനങള എനായിരികം ?

a) Create circle ടള ഉപേയാഗിച് വതം വരച് നിറം നലകി.

b) Create spiral ടള ഉപേയാഗിച് വതം വരച.

c) Edit paths by nodes   ടള ഉപേയാഗിച് ആവശയമള ഭാഗത് നിറം നലകി.

d) Gradient tool െല Radial gradient െതരെഞടത് വതതില ഡബിള കിക് െചയ.

Answer:

a) Create circle ടള ഉപേയാഗിച് വതം വരച് നിറം നലകി.
d) Gradient tool െല Radial gradient െതരെഞടത് വതതില ഡബിള കിക് െചയ.

9. ഇങ്േസപില ഉപേയാഗികന  duplicate  എന സേങതവം  clone   എന സേങതവം താരതമയം 
െചയാല 

a) രണം പകരെപടകാനളതാണ് 
b) duplicate എടകേമാള നിറവയതയാസം ഉണാകം 
c) duplicate  എടതാല പിെന  അതില മാറം വരതാന കഴിയില
d) യഥാരത ചിതതില വരതന മാറം അതിെന clone ലം ദശയമാകം

Answer:
a )രണം പകരെപടകാനളതാണ് 
d )യഥാരത ചിതതില  വരതന മാറം അതിെന clone ലം ദശയമാകം



10. ഇങ്േസപില സഭാഷ്  വരച ഒര പരണവതെത അരദവതമാകി മാറാന സവീകരികാവന  2 
മാരഗങള കെണതക ?

a) വതം വരച് edit path by node tool ഉപേയാഗിച് അരദവതമാകക
b) വതം വരച് edit  cut – ഉപേയാഗികക
c) വതം വരച് object Flip vertical – ഉപേയാഗികക
d) വതം വരച് കണേടാളസ് ബാറില start, end കമീകരികക

Answer:
a) വതം വരച് edit path by node tool ഉപേയാഗിച്  അരദവതമാകക
d) വതം വരച് കണേടാളസ് ബാറില start, end കമീകരികക

11. ഓപണഓഫീസ് സ്െപഡഷീറില LOOKUP ഫങഷന വിസാരഡില നേലണ വിവരങള

  a) Search criterion 
  b) Search vector  
  c) Search data
  d) Search file

Answer: a) Search criterian 
b) Search vector   

12.  സ്െപഡ് ഷീറില Lookup Chart തയാറാകേമാള ശദിേകണ  നിബനനകള  

a) Lookup  Chart തയാറാകേമാള ശനയമായ െസലകള ഉളെപടരത്.
b) Lookup  Chart ന് പടികയിെല േകാളതിന തലയം േകാളങള േവണം.
d) Lookup  Chart തയാറാകേമാള ഒര െസലില ഒര വില  മാതേമ ൈടപ് െചയാവ

Answer:       a)  Lookup  Chart തയാറാകേമാള ശനയമായ െസലകള ഉളെപടരത്.
d)  Lookup  Chart തയാറാകേമാള ഒര െസലില ഒര വില  മാതേമ ൈടപ് െചയാവ

13. ഓപണ ഓഫീസ് സ്പഡഷീറില  ഉളെപടതിയ വിവരങളില ഉയരം 165 cm ല കടതലാണങില 
ELIGIBLE എനം  അലങില NOT ELIGIBLE എനം കാണികാന IF ഫങഷന വിസാരഡിെല 
Then_Value ഫീലഡിലം Otherwise_Value ഫീലഡിലം    ൈടപ്  െചേയണത്   താെഴ 
കാണനതില ഏെതാെക രീതികളിലാണ് ?

a)  Then_Value േബാകില  "ELIGIBLE”
b)  Otherwise_Value േബാകില " ELIGIBLE”
c)  Then_Value േബാകില  "NOT ELIGIBLE”
d)  Otherwise_Value േബാകില " NOT ELIGIBLE”

Answer: a) Then_Value േബാകില  "ELIGIBLE”
        d) Otherwise_Value േബാകില " NOT ELIGIBLE”



14. താെഴ  െകാടതിരികനവയില  നിന്  ഡാററകെള  വരഗീകരീകാനായി  ഓപണഓഫീസ് 
സ്പഡഷീറില ലഭയമായ രണ് ഫങഷനകള കെണതക .

  a)  IF
   b)  COUNT

  c)  SUM
  d)  LOOKUP

Answer:  a)  IF
      d)  LOOKUP

15. IF എന ഫങഷെന ഉപേയാഗം സംബനിച് ശരിയായ പസാവനകള ഏെതലാം ?

a. തക കാണാന സഹായികന
b. േഡാകയെമനിെല ആവശയമള ഭാഗം മാതം പിെനടകനതിന് സഹായികന
c. സ്െപഡഷീറ് േഡാകയെമനിെല ഒര സേങതമാണിത്
d. ഒര പടികയിലളെപട വിവരങെള നമകാവശയമായ രീതിയില തരംതിരികാന സഹായികന

Answer :
 c. സ്െപഡഷീറ് േഡാകയെമനിെല ഒര സേങതമാണിത്

         d. ഒര പടികയിലളെപട വിവരങെള നമകാവശയമായ രീതിയില തരംതിരികാന   
    സഹായികന

16. ഓപണ  ഓഫീസ്  ഡാറാേബസില   പടിക  തയാറാകാന  താെഴകാണനവയില  നിനം   രണ 
മാരഗങള െതരെഞടകക

a) Create Forms in Design View
b) Create Table in Design View
c) Use Wizard to Create Table
d) Use Wizard to Create Form

Answer: b) Create Table in Design View
c) Use Wizard  to Create  Table

17. ഓപണഓഫീസ്  ഡാറാേബസില  Use  Wizard  to  Create  Form  െല  രണ്  െസപകള  താെഴ 
െകാടതവയിലണ്. അവ ഏെതന് കണപിടിയാേമാ ?

a ) Field selection
b) Apply styles
c) Insert address block
d) Edit document

             
          Answer:  a ) Field selection 

     b) Apply styles



18. കയജിസ്   േസാഫ്െവയര  ഉപേയാഗിച്   തയാറാകന  ഭപടതില   New  Print  Composer 
ജാലകം ഉപേയാഗിച് െചയാന കഴിയന പവരതനങള ഏെതലാം ?

a)  Toggle Editing select െചയ് കയാനവാസില കിക് െചയാല  ഭപടം ദശയമാകാന കഴിയം
b) Add New Label ടള ഉപേയാഗിച്  ഭപടതിന് തലെകട് നലകവാന കഴിയം .
c) Add New Vector Legend റള ഉപേയാഗിച് ഭപടതില Legend ഉളെപടതാന കഴിയം
d)  Add North Line ടള ഉപേയാഗിച്  അനേയാജയമായ North line ഉളെപടതാനാകം.

Answer:  b)  Add New Label ടള ഉപേയാഗിച്  ഭപടതിന് തലെകട് നലകവാന കഴിയം .
      c)  Add New Vector Legend റള ഉപേയാഗിച് ഭപടതില Legend ഉളെപടതാന കഴിയം

കവാണം ജിഐഎസ്  േസാഫ് െവയറിെല െലയര ൈടപകള കെണതക?

a) Point
b) Line
c) Triangle
d) Square
 
Answer: a) Point 

    b) Line

19. വികീമാപിയയില  നിങളെട  വീടിെന  സാനം  ഉളെപടതനതിന്  ഉപേയാഗികാവന  ടളകള 
ഏെതലാം?

a) Search
b) Toggle Editing
c) Attributes
d) Add place

Ans: A. Search  
D. Add place

20. ശരിയായ പസാവനകള ഏതലാം കെണതക ?

a.  വികിമാപിയയില  സലങള  ,  േറാഡകള  ,  സാപനങള,  ആരാധനാലയങള 
മതലായവയെട േപരകള അടയാളെപടതാന സാധികന.

b. വികിമാപിയയില സാറൈലറ് വയ ,മാപ് വയ എനീ രണ രീതികളില ഭപടം നിരീകികാന
സൗകരയമണ്.

c.  വികിമാപിയയില  േറാഡിെന  വീതി കടേമാള ഏെതലാം െകടിടങെള ബാധികെമന് 
കെണതാന ബഫറിംങ് എന സേങതമണ്.
d. വികിമാപിയ QGIS ഭപടമാണ്

Answer :  a. വികിമാപിയയില സലങള , േറാഡകള , സാപനങള, ആരാധനാലയങള 
മതലായവയെട േപരകള അടയാളെപടതാന സാധികന.

     b.  വികിമാപിയയില സാറ്  ൈലറ് വയ ,  മാപ്  വയ എനീ രണ രീതികളില ഭപടം 
നിരീകികാന സൗകരയമണ്.



21. ഒര  പഞായതിെന  കയജിസ്  ഭപടതില േരഖെപടതിയിടള  വീടകളെട  വിവരങള 
ദശയമാകനതിനള പവരതനങള  െതരെഞടകക.?

a) വീട് -പാളി  െസലക് െചയതിനേശഷം Identify Feature tool കിക്  െചയ് വീടകള  െസലക് 
െചയന.

b) വീട് -പാളി  െസലക് െചയതിനേശഷം Capture Point button  കിക്  െചയ് വീടകളില വീണം 
കിക് െചയന. 

c) വീട് -പാളി  െസലക് െചയതിനേശഷം വീട് െലയറില ൈററ് കിക്  െചയ്  Open attribute  
table-ല കിക് െചയന.

d) വീട്  -പാളി  െസലക് െചയതിനേശഷം വീട് െലയറ് െതരെഞടത് Toggle Editing കിക്  
െചയന.

Answer :   a)  വീട ്  -പാളി  െസലക് െചയതിനേശഷം identify feature  tool  കിക്   െചയ്  
  വീടകള െസലക ്  െചയന.

  c)  വീട്  -പാളി  െസലക് െചയതിനേശഷം വീട ്  െലയറില ൈററ്  കിക്   െചയ്   
       Open attribute  table-ല കിക് െചയന.

22. കയജിസമായി  ബനെപട ശരിയായ  പസ്താവനകള  ഏെതലാം ?

a) വിവര വിശകലനം സാദയമാണ്.
b) ആവതി വിശകലനം (Buffer(s))സാദയമാണ്.
c) ആകാശ നിരീകണം  സാദയമാണ്.
d) ആവശയമായ കടിേചരകലകള  സാദയമല.

Answer: a) വിവര വിശകലനം സാദയമാണ് .
b) ആവതി വിശകലനം (Buffer(s))സാദയമാണ്.

23. കയജിസ് േസാഫ്െവയറില  തയാറാകിയ  ഭപടം Save െചയാന കഴിയന ഫയല േഫാരമാറകള 
ഏെതാെകയാണ്. 

a) pdf
b) avi
c) xcf

      d) svg

Answer: a)  pdf
b)  svg

24. ഒന മതല 10 വെരയള സംഖയകള പവരതനഫലം(output) ആയി ലഭികനതിനള ൈപതണ 
േകാഡകള  ഏവ ?
a)  for i in range(1,11):

               print i 
b)  for i in range(0,10,1)

                print i 
c)   i=0

          while(i<=10):
                  print i 
                  i=i+1

d)     i=1
                   while(i<=10):
                   print i 
                 i=i+1



Answer  : a) for i in range(1,11):
                 print i 
         d) i=1
             while(i<=10):
                 print i 
                 i=i+1

25.                       s=raw_input( Type Your Name and Press ENTER key ) “ ”
 n=len(s) 
 for i in range(n+1): 

        print s[:i]
                 

ഈ ൈപതണ േപാഗാമിെന അടിസാനമാകിയള ഏതാനം പസാവനകള നലകിയിരികന. 
ഇവ പരിേശാധിച് ഏറവം അനേയാജയമായ രെണണം തിരെഞടകക ?
 

a) ൈടപ്  െചയ്  നലകന  േപരില  എത  അകരങളെണന്  എണനതിനാണ്    
േപാഗാമിെല  രണാമെത വരി.

b) ൈടപ്  െചയ്  നലകന  േപരിെല  അകരങെള  വലിയ  അകരങളാകനതിനാണ്  
േപാഗാമിെല രണാമെത വരി.

c) േപാഗാമിെല  നാലാമെത  വരി  print  s[i:]  എനാകിയാല  ഈ  േപാഗാം  
പവരതികില.

  d) േപാഗാമിെല നാലാമെത വരി print s[i:] എന് മാറിയാലം ഈ േപാഗാം പവരതികം.

Answer : 
b)ൈടപ്  െചയ്  നലകന  േപരില  എത  അകരങളെണന്  എണനതിനാണ്  േപാഗാമിെല  
  രണാമെത വരി.
d)േപാഗാമിെല നാലാമെത വരി print s[i:] എന് മാറിയാലം ഈ േപാഗാം പവരതികം.

26. ൈപതണ േപാഗാമില ഉപേയാഗികന ഒര ചിഹമാണ് '+'. ഇത് താെഴ പറയന ഏെതലാം   
പവരതനങളക് ഉപേയാഗികാം ?

a) രണ സംഖയകളെട തക കാണനതിന്
b) രണ സിങകള കടിേചരകനതിന്
c) േകാഡകള തിരികവാന
d) സംഖയകള പിന് െചയനതിന്

 Answer :   a) രണ സംഖയകളെട തക കാണനതിന്
                         b) രണ സിങകള കടിേചരകനതിന്

27. താെഴ െകാടതിരികന പസാവനകളില ൈപതണ േപാഗാമകളിെല സിങകെള സംബനിച് 
ശരിയായ പസാവനകേളവ ?

a) അകര രപതിലള ഡാറയാണ് സിങ്.
b) സിങകള '+' ചിഹം ഉപേയാഗിച് കടിേചരകാന സാധയമല
c) സിങ് എനാല സംഖയകെള സചിപികന
d) ഉദരണിയില നലന സംഖയകള സിങകളാണ്

Answer :  a) അകര രപതിലള ഡാറയാണ് സിങ് .
     d) ഉദരണിയില നലന സംഖയകള സിങകളാണ്



28. രണ്  സംഖയകളെട  തക കാണനതിനള േപാഗാം  അരജനം  അശവിനം  ൈപതണ ഭാഷയില 
താെഴതനിരികന രീതിയില തയാറാകി.

a=input( Enter First Number )“ ”
b=input( Enter Second Number )“ ”
c=a+b
print c

Save  െചയ േപാഗാം പവരതിപിചേപാള അരജന  input  ആയി  5,3  എനം അശവിന  '5','3'  
എനം നലകി. താെഴതനിരികനവയില 2 പസാവനകള ശരിയാണ്? ഏെതലാം 

 a) അരജന് 8 എന ഉതരം ലഭിച. 
b) അരജന്  53 എന ഉതരം ലഭിച.      
c) അശവിന്  53 എന ഉതരം ലഭിച.
d) അശവിന് 8 എന ഉതരം ലഭിച.

Answer     :    a) അരജന് 8 എന ഉതരം ലഭിച.
     c) അശവിന്  53 എന ഉതരം ലഭിച.

29. Python ഭാഷയമായി  ബനമള നിരേദശങള കെണതാന രാജവിെന സഹായികാേമാ  ?

a) for i in range(5):
b) raw_input
c) look up
d) Count if

Answer :  a)  for i  in range(5):
b)  raw_input

30 ൈപതണ േപാഗാമില ഫങഷനകെളകറിച്  േതാമസം രമയയം കെണതിയ കാരയങളാണ്  
താെഴെകാടതിരികനത്. ഇതില ശരിയായ പസാവനകള െതരഞടകക .

a) സവതനമായി നിലകന സബ് േപാഗാമകളാണ്
b) ഒര േപാഗാമില ഉളെപടന formula കള ആണ്.
c) ഒര പധാന േപാഗാമില പേയാജനെപടതാവന േപാഗാമകളാണ്
d) ഒര program -ല ഗണിതകിയകെള കറിയന നിരേദശമാണ്.

Answer :      a) സവതനമായി നിലകന സബ് േപാഗാമകളാണ്
         c) ഒര പധാന േപാഗാമില പേയാജനെപടതാവന േപാഗാമകളാണ്

31. രണ് സംഖയകള തമില കടനതിനള ഒര ഫങഷന sum എന േപരില തയാറാകി add.py എന 
േപരില സകിചിടണ്. രമയ് ഈ ഫങഷന തെന  അടത േപാഗാമില ഉളെപടതണം.അതിനള 
പവരതന ഘടങള താെഴ നലയിരികന. ശരിയായവ കെണതക (രെണണം) ?

a)  import add എന നിരേദശം േപാഗാമിെന  ആദയവരിയില എഴതക
b)  import sum എന നിരേദശം േപാഗാമിെന  ആദയവരിയില എഴതക
c)  print add.sum(45,56) എന നിരേദശം േപാഗാമിെന രണാമെത വരിയില എഴതക
d) print myfunction.sum(45,56) എന നിരേദശം േപാഗാമിെന രണാമെത വരിയില എഴതക

Answer:    a) import add എന നിരേദശം േപാഗാമിെന  ആദയവരിയില എഴതക
    c) print add.sum(45,56) എന നിരേദശം േപാഗാമിെന രണാമെത വരിയില എഴതക



32. ഒര ൈപതണ േപാഗാമിേലയ്  ഡാറ ഇനപടായി നലകനതിന്  ഉപേയാഗികന നിരേദശങള 
ഏെതലാം ?

           a)  rawinput
           b)  raw_input

c)  import
d)  input

Answer :  b)  raw_input
    d)  input

  



വിഭാഗം 3 : കറിപ് തയാറകക
(ഓേരാ െസറില നിനം ഏറവം അനേയാജയമായ  ഉതരം െതരഞടത് , തനിടള 

വിഷയെതകറിച് കറിപ് പരതിയാകക - 2  േസാര)

1. കറിപ് തയാറാകക : ഇങ്േസപ് 

െസറ് 1
A) ഒര റാസര ചിത നിരമാണ േസാഫ് െവയറാണിത്.
B) ഒര െവകര ചിത നിരമാണ േസാഫ് െവയറാണിത്.
C) ഒര 3D ആനിേമഷന നിരമാണ േസാഫ് െവയറാണിത്.
D) ഒര അറ് ലസ്  നിരമാണ േസാഫ് െവയറാണിത്.

Answer :B) ഒര െവകര ചിത നിരമാണ േസാഫ് െവയറാണിത് .

െസറ് 2
 

A) ഇതില  നിശിത വലിപതിലള കാനവാസ് നിരമികാന  Open -> New Canvas എന 
രീതിയില കിക െചയന.

B)  ഇതില  നിശിത വലിപതിലള കാനവാസ് നിരമികാന File  -> Document Properties കിക 
െചയന.

C) ഇതില  നിശിത വലിപതിലള കാനവാസ് നിരമികാന  Layer ->  Add layer എന 
രീതിയില കിക െചയന.

D) ഇതില നിശിത വലിപതിലള കാനവാസ് നിരമികാന Create -> New Document കിക 
െചയന.

Answer:  B)  ഇതില   നിശിത  വലിപതിലള  കാനവാസ്  നിരമികാന  File   -> 
Document Properties കിക െചയന.



െസറ് 3
A)  ഇതില Move Tool ഉപേയാഗിചാണചിതങളെട സാനം, വലപം എനിവ കമീകരികനത്.
B) ഇതില Select and Transform Object Tool ഉപേയാഗിചാണചിതങളെട സാനം, വലപം 

എനിവ കമീകരികനത്.
C) ഇതില Edit path by Node Tool ഉപേയാഗിചാണചിതങളെട സാനം, വലപം എനിവ 

കമീകരികനത്. 
D) ഇതില Zoom in or out Tool ഉപേയാഗിചാണചിതങളെട സാനം, വലപം എനിവ 

കമീകരികനത്.

Answer:B)  ഇതില Select and Transform Object Tool ഉപേയാഗിചാണചിതങളെട 
സാനം, വലപം എനിവ കമീകരികനത്.

െസറ് 4

A) ഈ േസാഫ് െവയറില നിരമികന ചിതങളെട സവാഭാവിക ഫയല േഫാരമാറ്  jpg ആണ്.
B) ഈ േസാഫ് െവയറില നിരമികന ചിതങളെട സവാഭാവിക ഫയല േഫാരമാറ്  xcf ആണ്.
C) ഈ േസാഫ് െവയറില നിരമികന ചിതങളെട സവാഭാവിക ഫയല േഫാരമാറ്  svg ആണ്.
D) ഈ േസാഫ് െവയറില നിരമികന ചിതങളെട സവാഭാവിക ഫയല േഫാരമാറ്  gif ആണ്.

Answer: C) ഈ േസാഫ് െവയറില നിരമികന ചിതങളെട സവാഭാവിക ഫയല 
േഫാരമാറ്   svg ആണ്.

2. കറിപ് തയാറാകക : െവകര ഫയലകള

െസറ് 1

A) െവകര ഫയലകളില ചിതമടങന പതലതിെല ഓേരാബിനവിെന സാനവം നിറവം 
േരഖപടതിെവകന

B) െവകര ഫയലകളില ചിതതിെന അഗബിനകളെട സാനവം നിറവം മാതം 
േരഖെപടതിെവകന

C) െവകര ഫയലകളില ചിതതിെന നിറം മാതം േരഖെപടതിെവയന

D) െവകര ഫയലകളില ചിതതിെന വലപം മാതം േരഖെപടതിെവയന

Answer:  B.)  ചിതതിെനഅഗബിനകളെട  സാനവം  നിറവം  മാതം  േരഖെപടതി 
െവകന

െസറ് 2
A) ചിതങെള പികലകളെട സമഹമായാണ് പരിഗണികനത്

B) ചിതങെള വിവിധ നിറങളായാണ് പരിഗണികനത്

C) ചിതങെള ഒെരാറ വലിയ  പികലായാണ് പരിഗണികനത്

D) ചിതങെള േരഖകള,ചതരങള, വതങള,വകേരഖകള തടങിയ ജയാമിതീയ രപങളായാണ് 
പരിഗണികനത്.

Answer:  D) ചിതങെള  േരഖകള,ചതരങള,  വതങള,വകേരഖകള  തടങിയ 
ജയാമിതീയ രപങളായാണ് പരിഗണികനത് .



െസറ്3

A) ചിതം  വലതാകേമാള വലതാകിയ പതലതിെല പതിയ ബിനകള കെണതി 
േരഖെപടതന

B) ചിതം  വലതാകേമാള പഴയ പതലം മായച കളയന

C) ചിതം  വലതാകേമാള നിറം നലിയ ചതരങള വലതാകന

D) ചിതം  വലതാകേമാള പശാതല നിറം മാറന

Answer: A) ചിതം   വലതാകേമാള  വലതാകിയ  പതലതിെല  പതിയ  ബിനകള 
കെണതി േരഖെപടതന

െസറ് 4

A) ചിതം വലതാകേമാള വയകത നഷപടന

B) ചിതം വലതാകേമാള നിറം മാറന

C) ചിതം വലതാകേമാള  വയകത കറയനില

D) ചിതം വലതാകേമാള ആകതി നഷപടന

Answer: C) ചിതം വലതാകേമാള  വയകത കറയനില

3. കറിപ് തയാറാകക: റാസര ഫയലകള 

െസറ് 1

A) വലതാകേമാള വയകതയ് മാറം ഉണാകാതവയാണ് റാസര ഫയലകള.

B) വലതാകേമാള  വയകത നഷെപടനവയാണ് റാസര ഫയലകള.

C) വലതാകേനാറം വയകത കടിവരനവയാണ് റാസര ഫയലകള.

D) വയകത ഒടം തെന ഇലാതവയാണ് റാസര ഫയലകള.

Answer :B) വലതാകേമാള  വയകത നഷെപടനവയാണ് റാസര ഫയലകള.

െസറ്  2

A) റാസര ഫയലകള മാതം നിരമികാന കഴിയന ഒര േസാഫ്െവയറാണ് ഇങ്േസപ് .

B) റാസര ഫയലകള മാതം നിരമികാന കഴിയന ഒര േസാഫ്െവയറാണ് ഡയ .

C) റാസര ഫയലകള മാതം നിരമികാന കഴിയന ഒര േസാഫ്െവയറാണ് ഓപണ ഓഫീസ്  
േഡാ.

D) റാസര ഫയലകള നിരമികാന കഴിയന ഒര േസാഫ്െവയറാണ് ജിമ് .

Answer :A) റാസര ഫയലകള  നിരമികാന കഴിയന ഒര േസാഫ്െവയറാണ് ജിമ് .



െസറ്   3

A) റാസര ചിതമായി ഒര വര വരയേമാള അതയം ഭാഗെത ചതരങള(Pixels)ക് നിറം 
നലകകയാണ് കമയടര െചയനത്. 

B) റാസര ചിതമായി ഒര വര വരയേമാള ആ േരഖയെട നിറവം അഗബിനകളെട സാനവം മാതം 
േരഖെപടതകയാണ് കമയടര െചയനത്. 

C) റാസര ചിതമായി ഒര വര വരയേമാള അതിെന ജയാമിതീയ രപങളായി  േരഖെപടതകയാണ് 
കമയടര െചയനത്. 

D) റാസര ചിതമായി ഒര വര വരയേമാള അതിെന ഗണിത സമവാകയങളായി 
േരഖെപടതകയാണ് കമയടര െചയനത്. 

Answer :A) റാസര  ചിതമായി  ഒര  വര  വരയേമാള  അതയം  ഭാഗെത 
ചതരങള(Pixels)ക് നിറം നലകകയാണ് കമയടര െചയനത് . 

െസറ്  4

A) ഇങ്േസപില നിരമികന svg ഫയലകള റാസര ഫയലകളാണ്. 

B) ജിമില നിരമികന jpg ഫയലകള റാസര ഫയലകളാണ്. 

C) ഓപണ ഓഫീസില നിരമികന odt ഫയലകള റാസര ഫയലകളാണ്. 

D) ഓപണ ഓഫീസില നിരമികന ods ഫയലകള റാസര ഫയലകളാണ്. 

Answer :B) ജിമില നിരമികന .jpeg ഫയലകള റാസര ഫയലകളാണ്. 

4. കറിപ് തയാറാകക : െമയില െമരജ്

െസറ് 1

A) ഒര ഡാറാേബസിെല വിവരങെള  ഒര കണീഷന ഉപേയാഗിച് തരം തിരികാന ഈ 
സേങതം ഉപേയാഗികാം.

B) ഒര സാനീയ വിവരതിന ചറം നിശിത അകലം വെര ഒര പേതയക േമഖല സഷികന 
സേങതമാണ് െമയില െമരജ്.

C) ഒര കതിെല സവീകരതാവ് എനിടേതക് ഒര േഡറാ േബസിലള വിവിധ അഡസകള 
േചരത് പല കതകള തയാറാകനതിന്  ഈ സേങതം ഉപേയാഗികാം.

D) ഒര മാപിെല ഒര െലയറിലള എലാ വീടകളേടയം വിവരങള ലഭികാനള സേങതമാണ് 
െമയില െമരജ്.

Answer :  C) ഒര കതിെല സവീകരതാവ്  എനിടേതക് ഒര േഡറാേബസിലള വിവിധ  
അഡസകള  േചരത്  പല  കതകള  തയാറാകനതിന്   ഈ   സേങതം  
ഉപേയാഗികാം.



െസറ്  2

A) േവരഡ് േപാസസറില െടംേപറ് തയാറാകിയ േശഷം ടളസിെല  Mail Merge Wizard  വഴി 
ഇത്  തറകാം

B) ഡാറാേബസില െടംേപറ് തയാറാകിയ േശഷം ടളസിെല Mail Merge Wizard  വഴി ഇത് 
തറകാം

C) േവഡ് േപാസസറില െടംേപറ് തയാറാകിയ േശഷം േടബിളിെല Mail Merge Wizard  വഴി ഇത് 
തറകാം

D) സ്െപഡഷീറില െടംേപറ് തയാറാകിയ േശഷം േടബിളിെല Mail Merge Wizard  വഴി ഇത് 
തറകാം

Answer :   (a) േവരഡ് േപാസസറില െടംേപറ് തയാറാകിയ േശഷം ടളസിെല 
Mail Merge Wizard വഴി ഇത് തറകാം

െസറ് 3

A) പടികയിെല വിവരങള ഓേരാനം േഡാകയെമനിെല ആവശയമായ ഭാഗേതക് േകാപി 
െചയിടണം.

B) ഡാറാേബസിെല ശീരഷകങള ഒഴിെകയള വിവരങള  േഡാകയെമനിെല ആവശയമായ 
ഭാഗേതക് ഡാഗ് െചയിടണം.

C) പടികയിെല ശീരഷകങള  ഓേരാനം ആവശയമായ ഭാഗേതക് ഡാഗ് െചയിടണം.
D) ഡാറാേബസിെല വിവരങെളലാം േഡാകയെമനിെല ആവശയമായ ഭാഗേതക് േകാപി 

െചയിടണം.

Answer :   C) പടികയിെല  ശീരഷകങള   ഓേരാനം  ആവശയമായ  ഭാഗേതക്  
ഡാഗ് െചയിടണം.

െസറ് 4
A) തടരന് Save merged document  െതരെഞടത് േസവ് െചയക
B) തടരന് ഫയല െമനവിെല Save as ഉപേയാഗിച് േഡാകയെമന് േസവ് െചയക
C) തടരന് ഫയല െമനവിെല Export as PDF ഉപേയാഗിച് േഡാകയെമന് േസവ് െചയക
D) തടരന് എഡിറ്  െമനവിെല Save page as ഉപേയാഗിച് േഡാകയെമന് േസവ് െചയക

Answer : A) തടരന് Save merged document   െതരെഞടത് േസവ് െചയക

5. കറിപ് തയാറാകക : LOOKUP

െസറ് 1

A) പടിക തയാറാകിയ ഷീറില  Lookup Chart തയാറാകാം.
B) Lookup Chart തയാറാേകണത്  േഹാം േഫാളഡറില ആയിരികണം
C) Lookup Chart തയാറാേകണത്  Insert െമനവിെല  table വഴിയാണ്.
D) OpenOffice.org writer ലാണ് Lookup Chart തയാറാേകണത്.

Answer  :   A) പടിക തയാറാകിയ ഷീറില  Lookup Chart തയാറാകാം.



െസറ് 2

A) Lookup Chart െന ഒര പേതയക ഫയലായി േസവ് െചേയണതണ്.
B) Lookup Chart െന Define range വഴി േസവ് െചയാം.
C) Lookup Chart െന Sort range വഴി േസവ് െചയാം.
D) Lookup Chart െന .odt എന extention നലി േസവ് െചയണം. 

Answer :   B) Lookup Chart െന Define range വഴി േസവ് െചയാം.

െസറ് 3

A) Lookup Chart െല ഒനാമെത േകാളതിെല (Search vector)  വിലകള 
ആേരാഹണകമതിലായിരികണം. 

B) Lookup Chart െല ഒനാമെത േകാളതിെല (Search vector)  വിലകള 
അവഹരണകമതിലായിരികണം.

C) Lookup Chart െല ഒനാമെത േകാളതിെല (Search vector)  വിലകളക് പേതയക കമം 
ആവശയമില.

D) Lookup Chart െല ഒനാമെത േകാളതില (Search vector)  വിലകള സംഖയകള മാതേമ 
പാടള

Answer :  A) Lookup Chart െല ഒനാമെത േകാളതിെല (Search vector)  
വിലകള ആേരാഹണകമതിലായിരികണം. 

െസറ് 4

A) ടളസ് െമനവിെല Function  വഴി LOOKUP Function  ഉളെപടതാം.
B) േഫാരമാറ് െമനവിെല Function വഴി LOOKUP Function ഉളെപടതാം.
C) ഇനേസരട് െമനവിെല Function വഴി  LOOKUP Function ഉളെപടതാം.
D) ഡാറ  െമനവിെല Function വഴി  LOOKUP Function  ഉളെപടതാം.

Answer  :  C)   ഇനേസരട്  െമനവിെല Function  വഴി   LOOKUP  Function 
ഉളെപടതാം

6. കറിപ് തയാറാകക : ഡാറാേബസ്

 െസറ് 1

A) ഒര പേതയക ആവശയതിനായി േശഖരിചവചിടള വിവരങളെട കടമാണ്   Database.
B) അകര രപതില മാതം േശഖരിചവചിടള വിവരങളെട കടമാണ്   Database.
C) OpenOffice.org Draw ഉപേയാഗിച് േശഖരികന വിവരങളെട കടമാണ്   Database.
D)  OpenOffice.org Writer  ഉപേയാഗിച് േശഖരികന വിവരങളെട കടമാണ്   Database.

Answer :   A) ഒര പേതയക ആവശയതിനായി േശഖരിചവചിടള വിവരങളെട 
  കടമാണ്   Database.



െസറ് 2

A) Database ല വിവരങള െതരയനതിനള സംവിധാനമാണ് Database Management System 
(DBMS) .

B) ഡാറാേബസ് നിരമികനതിനം  ൈകകാരയം െചയനതിനമള   േസാഫ്െവയറകളാണ്  
Database Management System (DBMS) .

C) OpenOffice.org Spreadsheet െന മെറാര  േപരാണ് Database Management System(DBMS).
D) വിവിധ ഓഫീസ് പവരതനങള ൈകകാരയം െചയനതിനള  േസാഫ്െവയറകളാണ് Database 

Management System(DBMS) .

Answer :   B) ഡാറാേബസ് നിരമികനതിനം  ൈകകാരയം െചയനതിനമള   
  േസാഫ്െവയറകളാണ് Database Management System (DBMS) .

െസറ് 3

A)  ഒര ഡാറാേബസിെല പടികയിേലക്  വിവരങള നലകാനള സംവിധാനമാണ് Form
B)  ഒര ഡാറാേബസിെല പടികയിേലക്  വിവരങള നലകാനള സംവിധാനമാണ് Report.
C)  ഒര ഡാറാേബസിെല പടികയിേലക്  വിവരങള നലകനത്  OpenOffice.org Word Processor 

ഉപേയാഗിചാണ്.
D) ഒര ഡാറാേബസിെല പടികയിേലക്  വിവരങള നലകനത്  OpenOffice.org Presentation 

ഉപേയാഗിചാണ്.

Answer :  A) ഒര ഡാറാേബസിെല പടികയിേലക്  വിവരങള നലകാനള 
സംവിധാനമാണ് Form

െസറ് 4

A) ഡാറാേബസിെല ഓേരാ റിേകാരഡിെനയം മറളവയിലനിന്  തിരിചറിയനതിന്  Primary Key 
ഉപേയാഗികന.

B) ഡാറാേബസിെല ഓേരാ റിേകാരഡിെനയം  മറളവയിലനിന്  തിരിചറിയനതിനള 
സംവിധാനമാണ് Form.

C) ഡാറാേബസിെല ഓേരാ േടബിളിെനയം  മറളവയിലനിന്  തിരിചറിയനതിനള 
സംവിധാനമാണ്  Primary key

D) ഡാറാേബസിെല ഓേരാ േഫാമിെനയം മറളവയിലനിന്  തിരിചറിയനതിന്  Primary key 
ഉപേയാഗികന.

Answer :  A) ഡാറാേബസിെല ഓേരാ റിേകാരഡിെനയം മറളവയിലനിന്  
  തിരിചറിയനതിന്  Primary Key ഉപേയാഗികന.

7. കറിപ് തയാറാകക: DBMS(ഡാറാേബസ് മാേനജ്െമന് സിസം )

െസറ് 1

A) ദതങെള സരകിതമായി ൈകകാരയം െചയന ഒര േസാഫ് െവയര സംവിധാനമാണിത്.
B) ദതങെള പടികെപടതാന മാതം ഉപേയാഗികന ഒര േസാഫ്െവയര ആണിത് .
C) ദതങെള പാളികളായി േരഖെപടതന ഒര േസാഫ്െവയര സംവിധാനമാണിത് .
D) ദതങെള തയാറാകാനം േഫാരമാറ് െചയാനം ഉപേയാഗികന ഒര േസാഫ്െവയര ആണിത് .

Answer : A)  ദതങെള സരകിതമായി ൈകകാരയം െചയന ഒര േസാഫ്െവയര 
സംവിധാനമാണിത് .



െസറ് 2

A) ഡാറാേബസിേലക് ദതങള േചരകനതിനായി  േഫാം മാതം തയാറാകിയാല മതി.
B) ഡാറാേബസിേലക് ദതങള േചരകനതിനായി െടംേപറ് മാതം തയാറാകിയാല മതി.
C) ഡാറാേബസിേലക് ദതങള േചരകനതിനായി ഒര േടബിളം േഫാമം തയാറാകണം.
D) ഡാറാേബസിേലക് ദതങള േചരകനതിനായി അവ സാന െചയ് നലകിയാല മതി.

Answer  :  C)  ഡാറാേബസിേലക്  ദതങള  േചരകനതിനായി  ഒര  േടബിളം  
േഫാമം തയാറാകണം.

െസറ് 3

A) ഡാറാേബസിെല എലാ ഫീലഡിലം  വിവരങള  േചരകാന കഴിയില..
B) ഡാറാേബസിെല ഏത ഫീലഡിലം ഏത  തരം വിവരങളം  ഉളെപടതാന കഴിയം.
C) ഡാറാേബസിെല ഒര ഫീലഡില ഒര നിശിത തരം ദതം മാതേമ ഉളെപടതാന കഴിയകയള.
D) ഡാറാേബസിെല ഒനാമെത ഫീലഡില സംഖയകള മാതേമ ഉളെപടതാന കഴിയകയള.

Answer  :  C)  ഡാറാേബസിെല  ഒര  ഫീലഡില  ഒര  നിശിത  തരം  ദതം  മാതേമ  
ഉളെപടതാന കഴിയകയള .

െസറ് 4

A) OpenOffice.org ഡാറാേബസില തയാറാകന ഫയലിെന ഫയല േഫാരമാറ് odt ആണ്.
B) OpenOffice.org ഡാറാേബസില തയാറാകന ഫയലിെന ഫയല േഫാരമാറ് odb ആണ്.
C) OpenOffice.org ഡാറാേബസില തയാറാകന ഫയലിെന ഫയല േഫാരമാറ് ods ആണ്.
D) OpenOffice.org ഡാറാേബസില തയാറാകന ഫയലിെന ഫയല േഫാരമാറ് odd ആണ്.

Answer  :  B)   Open  Office  ഡാറാേബസില  തയാറാകന  ഫയലിെന   ഫയല  
േഫാരമാറ്  odb ആണ്.

8. കവാണം ജിസ്

െസറ് 1

A) File Menu-വിെല New Print Composer-ല കിക് െചയ്ത് കേമാസര ജാലകം തറകാം
B) File Menu-വിെല New Project-ല കിക് െചയ്ത് കേമാസര ജാലകം തറകാം
C) File Menu-വിെല Open Project-ല കിക് െചയ്ത് കേമാസര ജാലകം തറകാം
D) File Menu-വിെല Project Properties-ല കിക് െചയ്ത് കേമാസര ജാലകം തറകാം

Answer : A) File Menu-വിെല New Print Composer-ല കിക് െചയ്ത് കേമാസര  
ജാലകം തറകാം

െസറ് 2

A) കേമാസര ജാലകതില Add Label tool ഉപേയാഗിച്  ഭപടെത ദശയമാകാം
B) കേമാസര ജാലകതില Add Image  tool ഉപേയാഗിച്  ഭപടെത ദശയമാകാം
C) കേമാസര ജാലകതില Add Vector Legend tool ഉപേയാഗിച്  ഭപടെത ദശയമാകാം
D) കേമാസര ജാലകതില Add New Map tool ഉപേയാഗിച്  ഭപടെത ദശയമാകാം

Answer :  D) കേമാസര ജാലകതില Add New Map tool ഉപേയാഗിച്  ഭപടെത 
ദശയമാകാം

െസറ് 3



A) കേമാസര ജാലകതില Add New Label tool ഉപേയാഗിച്  North Line അടയാളെപടതാം
B) കേമാസര ജാലകതില Add Image  Tool ഉപേയാഗിച്  North Line അടയാളെപടതാം
C) കേമാസര ജാലകതില Add Vector Legend ഉപേയാഗിച്  North Line അടയാളെപടതാം
D) കേമാസര ജാലകതില Add New Map tool ഉപേയാഗിച്  North Line അടയാളെപടതാം

Answer : B) കേമാസര ജാലകതില Add Image  Tool ഉപേയാഗിച്  North Line 
അടയാളെപടതാം

െസറ് 4

A) കേമാസര ജാലകതില File -> Export as Image തറന്  അനേയാജയമായ Format-ല 
ഭപടെത േസവ് െചയാം

B) കേമാസര ജാലകതില File -> Save as Template തറന്  അനേയാജയമായ Format-ല 
ഭപടെത േസവ് െചയാം

C) കേമാസര ജാലകതില Layout -> Save as Template തറന്  അനേയാജയമായ Format-ല 
ഭപടെത േസവ് െചയാം

D) കേമാസര ജാലകതില Layout -> Export as Image തറന്  അനേയാജയമായ Format-ല 
ഭപടെത േസവ് െചയാം

Answer  :  A)  കേമാസര  ജാലകതില  File  ->  Export  as  Image  തറന്   
അനേയാജയമായ Format-ല ഭപടെത േസവ് െചയാം

9.  കയജിസ് േസാഫ്റ് െവയറില നിരമിച well എന പാളിയില വിവരങള കടിേചരകന പവരതനം.

െസറ് 1

A) Overview പാനലില നിനം well എന പാളി മറച വയക.
B) െലയര പാനലില നിനം well എന പാളി െതരെഞടകക.
C) view െമനവില നിനം well എന പാളി െതരെഞടകക
D) vector െമനവില നിനം well എന പാളി െതരെഞടകക

Answer :   B) െലയര പാനലില നിനം well എന പാളി െതരെഞടകക.

െസറ് 2

A) ടളബാറിെല toggle editing ബടണില കിക് െചയക
B) ടളബാറിെല node tool ബടണില കിക് െചയക
C) ടളബാറിെല add ring ബടണില കിക് െചയക
D) ടളബാറിെല add part ബടണില കിക് െചയക

Answer :    A) ടളബാറിെല toggle editing ബടണില കിക് െചയക



െസറ് 3

A) തടരന്  സജീവമാകന സമീപതളള polygon ബടണ അമരതക.
B) തടരന്  സജീവമാകന സമീപതളള line  ബടണ അമരതക.
C) തടരന്  സജീവമാകന സമീപതളള label  ബടണ അമരതക.
D) തടരന്  സജീവമാകന സമീപതളള capture point  ബടണ അമരതക.

Answer : D) തടരന്  സജീവമാകന സമീപതളള capture point  ബടണ അമരതക.
 

െസറ് 4

A) യഥാസാനത് കിക്  െചയ്  Attributes ജാലകതില േവണ വിവരങള നലക
B) യഥാസാനത്  കിക്  െചയ്  Vector ജാലകതില േവണ വിവരങള നലക.
C) യഥാസാനത് കിക്  െചയ്  Settings ജാലകതില േവണ വിവരങള നലക
D) യഥാസാനത്  കിക്  െചയ്  Raster ജാലകതില േവണ വിവരങള നലക

Answer:A)യഥാസാനത് കിക്   െചയ്   Attributes  ജാലകതില േവണ വിവരങള 
നലക. 

10. വികിമാപിയയെട സവിേശഷതകള 

െസറ് 1

A) വികിമാപിയ  QGIS ഭപടതിന് ഉദാഹരണമാണ്.
B) വികിമാപിയ സാധാരണ ഭപടതിന് ഉദാഹരണമാണ്.
C) വികിമാപിയ ഉപഗഹ ഭപടതിന് ഉദാഹരണമാണ്.
D) വികിമാപിയ െസരച് എഞിന് ഉദാഹരണമാണ്

Answer : C) വികിമാപിയ ഉപഗഹ ഭപടതിന് ഉദാഹരണമാണ് .

െസറ് 2

A) വികിമാപിയയില സലങള ,  േറാഡകള ,  സാപനങള, ആരാധനാലയങള മതലായവയെട 
േപരകള അടയാളെപടതാന സാധികന.

B) വികിമാപിയയില   േറാഡിെന   വീതി  കടേമാള  ഏെതലാം  െകടിടങെള  ബാധികെമന് 
കെണതാന ബഫറിംങ് എന സേങതമണ്.

C) വികിമാപിയയില  വിവരങള െലയര രീതിയില കടിേചരകാം
D) വികിമാപിയയില സലങള ,  േറാഡകള ,  സാപനങള, ആരാധനാലയങള മതലായവയെട 

േപരകള അടയാളെപടതാന സാധികനില.

Answer  :  A)വികിമാപിയയില  സലങള,   േറാഡകള,  സാപനങള,  
ആരാധനാലയങള മതലായവയെട  േപരകള  അടയാളെപടതാന  
സാധികന.



െസറ് 3

A) വികിമാപിയയില െകടിടം  പാളിയായി നലകേമാള ഇനം (layer type) ആയി  ബിന  നലകന.
B) വികിമാപിയയില സാറൈലറ് വയ ,മാപ് വയ എനീ രണ രീതികളില ഭപടം നിരീകികാന 

സൗകരയമണ്.
C) വികിമാപിയയില െപാതെകടിടം   പാളിയായി നലകേമാള ഇനം (layer type) ആയി 

േപാളിഗണ നലകന
D) വികിമാപിയയില കിണര  പാളിയായി നലകേമാള ഇനം (layer type) ആയി  ബിന നലകന.

Answer  :  B)  വികിമാപിയയില  സാറ്  ൈലറ്  വയ  ,മാപ്  വയ  എനീ  രണ  രീതികളില 
ഭപടം നിരീകികാന സൗകരയമണ് .

െസറ് 4

A) വികിമാപിയ തറന്  search െചയ്  നിങളെട സളിെന  സാനം കെണതാം.
B) വികിമാപിയയില നഗരങള മാതേമ കെണതാനാക.
C) വികിമാപിയയില  അതിരകളപാളിയായി  നലകേമാള  ഇനം  (layer  type)  ആയി   ബിന 

നലകന.
D) വികിമാപിയയില   േറാഡിെന   വീതി  കടേമാള  ഏെതലാം  െകടിടങെള  ബാധികെമന് 

കെണതാന ഫിലററിംങ് എന സേങതമണ്.

Answer :A) വികിമാപിയ തറന്  search െചയ്  നിങളെട സളിെന  സാനം കെണതാം

11. ൈപതണ

െസറ് 1
A) അകരരപതിലള ഡാറയാണ് സ്ടിങ്
B) സംഖയാരപതിലള  ഡാറയാണ് സ്ടിങ്
C) അകരരപതിലള ഡാറകളം എലാ സംഖയകളം േചരനതാണ് സ്ടിങ്
D) ചിതരപതിലള ഡാറയാണ് സ്ടിങ്

Answer: A) അകരരപതിലള ഡാറയാണ് സ്ടിങ്

െസറ് 2

A) ഒര ചരതിേലക് സ്ടിംങ് ഇനപട് നലകാന 'input' എന നിരേദശം ഉപേയാഗികന
B) 'for'  ഒര കണീഷണല നിരേദശമാണ്.
C) 'if' ഒര ആവരതന നിരേദശമാണ്
D) ഫങഷന നിരമികാന 'def 'എന നിരേദശം ഉപേയാഗികന

      Answer: D) ഫങഷന നിരമികാന 'def 'എന നിരേദശം ഉപേയാഗികന

െസറ് 3
A) a=range(1,10,1) എന നിരേദശതില a യെട തടക വില 10 ആണ്.
B) ൈപതണില  '+' ചിഹം രണ് സ്ടിംങകളെട തകകാണനതിനപേയാഗികന .
C) ആവരതന ചരതിെന തടക വില (ഉദാ : i = 0) while  നിരേദശതിന മനപ് നലണം
D) IDLE ഒര േപാഗാം  േകാഡ് ജനേറററാണ്.

Answer : C) ആവരതന ചരതിെന തടക വില (ഉദാ : i = 0) while  
നിരേദശതിന മനപ് നലണം



െസറ് 4
A) ഫങഷന പവരതികേമാള ഉതരം തിരിെക പധാന േപാഗാമിന ലഭികാന 'return' നിരേദശം 

ഉപേയാഗികന.
B) സംഖയകള  കടാനള  ഫങഷന  നിരമികേമാള  ഫങഷെന  േപര്  'sum'  എന  മാതെമ 

നലാനപാടള.
C) wxGlade ൈപതെണാഴിച് മെറാര ഭാഷയെടയം േകാഡ് ജനേറററല.
D) WYSIWYG  മാതകയിലള  ൈപതണ  േപാഗാം  നിരമികാന  'turtle'  േസാഫ്െവയര  

ഉപേയാഗികന.

Answer  :  A)   ഫങഷന  പവരതികേമാള  ഉതരം  തിരിെക  പധാന  േപാഗാമിന 
ലഭികാന 'return' നിരേദശം ഉപേയാഗികന.

12. രണ്  സംഖയകളെട  ശരാശരി  കെണതനതിനള  ൈപതണ  ഫംഗഷന 
നിരമിേകണിയിരികന. പസാവനകളില നിന് ശരിയായ ഓേരാന വീതം െതരെഞടകക ?

െസറ് 1

A) def average(a,b)

B) def average(a,b):

C)  average(a,b):

D) sum(a,b)

Answer : B) def average(a,b):

െസറ് 2
A)  c=a * b

B)  c=a/2

C)  c=a + b

D)  c=b/2

Answer  : C) c=a + b

െസറ് 3
A) x=c * c

B) x=c+a

C) x= c+b

D) x=c/2

Answer  :  D) x=c /2

െസറ് 4
A) return x

B) return a

C) return b

D) return c

Answer : A)return x



13. ൈപതണ ഫങഷന 

െസറ് 1 
A) േപാഗാമില ഉപേയാഗികന ഒര ആവരതന നിരേദശമാണ് ൈപതണ ഫങഷന
B) സവതനമായി നിലകന സബ് േപാഗാമകളാണ് ൈപതണ ഫങഷനകള 
C) ഒര േപാഗാമിംഗ് പഠന സഹായിയാണ് ഫങഷന
D) എലാ ൈപതണ േപാഗാമകളിലം ഫങഷന നിരബനമായം ഉപേയാഗിചിരികണം

Answer : B) സവതനമായി നിലകന സബ് േപാഗാമകളാണ് ൈപതണ 
ഫങഷനകള 

െസറ് 2 

A) for നിരേദശം ഉപേയാഗിചാണ് ഫങഷന നിരമികനത്
B) def നിരേദശം ഉപേയാഗിചാണ് ഫങഷന നിരമികനത്
C) define നിരേദശം ഉപേയാഗിചാണ് ഫങഷന നിരമികനത്
D) പേതയക നിരേദശെമാനം നലകാെത തെന ഫങഷന നിരമികാം

Answer :  B) def നിരേദശം ഉപേയാഗിചാണ് ഫങഷന നിരമികനത്

െസറ് 3

A) ആവശയമള സനരഭങളില മറ് േപാഗാമകളക് ഫങഷനകെള പേയാജനെപടതാന കഴിയം
B) മറ് േപാഗാമകളക് ഫങഷനകള പേയാജനെപടതാന കഴിയില
C) ഒര േപാഗാമില ഒര ഫങഷന മാതെമ ഉപേയാഗികാന കഴിയ
D) എലാ േപാഗാമകളിലം ഫങഷനകള  നിരബനമാണ്

Answer : A) ആവശയമള സനരഭങളില മറ് േപാഗാമകളക് ഫങഷനകെള 
പേയാജനെപടതാന കഴിയം

െസറ് 4

A) ഫങഷന  പവരതികേമാള  ഉണാകന  പവരതനഫലം  തിരിെക  പധാന  േപാഗാമില 
ലഭികനതിന് return നിരേദശം നലകണം

B) ഫങഷന  പവരതികേമാള  ഉണാകന  പവരതനഫലം  തിരിെക  പധാന  േപാഗാമില 
ലഭികനതിന് return back നിരേദശം നലകണം

C) ഫങഷന  പവരതികേമാള  ഉണാകന  പവരതനഫലം  തിരിെക  പധാന  േപാഗാമില 
ലഭികനതിന് rt നിരേദശം നലകണം

D) ഫങഷന  പവരതികേമാള  ഉണാകന  പവരതനഫലം  തിരിെക  പധാന  േപാഗാമില 
ലഭികനതിന് പേതയക നിരേദശെമാനം നലേകണതില

Answer : A) ഫങഷന പവരതികേമാള ഉണാകന പവരതനഫലം തിരിെക 
പധാന േപാഗാമില ലഭികനതിന് return നിരേദശം നലകണം


